
Keywords: nontimber forest products; maple syrup; characterizing by numerical distribution; selecting features by attribute; 

buffering features; overlaying features; using VB code in Field Calculator; summarizing an attribute 

Calculating Forest Values 
Evaluating maple sap production potential 
—by Glen Jordan  

Introduction 

Problem 

How might a forest's value for maple syrup production be evaluated, aside from identifying sugar 
maple stands? Can a geographic information system (GIS) help? 

Forest value is found not only in primary timber products, such as pulpwood and sawlogs, but in an 
array of nontimber forest products (NTFP) that also add value to forests in many locales. NTFP 
includes medicinal and herbal products, edible products, decorative products, and specialty wood 
products. 

Maple sap, used for making maple syrup and other products, is one example in the edible forest 
products category. In central and northeastern North America, where sugar maple (Acer 
saccharum) trees are common on better sites, maple syrup production is a common and profitable 
enterprise. You can find much more information about maple syrup and its production on 
Wikipedia.  

Location 

A small, 1,400-hectare (ha) Woodlot in the Acadian-New England forest region of North America  

Time to complete the lab 

Three hours 

http://en.wikipedia.org/wiki/Maple_syrup
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Prerequisites 

A basic working knowledge of GIS data, including use of a geodatabase, and ArcGIS
®

 software in 
particular (Some knowledge of computer programming, Visual Basic [VB] in particular, would be 
helpful. A basic working knowledge of Excel, including pivot table calculation, is required. 
Familiarity with forest inventory data and terminology is also helpful but not essential.)  

Data used in this lab 

 Feature classes and rasters for a forest Woodlot (personal geodatabase) 

 Geographic coordinate system: NAD 1983 CSRS New Brunswick Stereographic 

 Datum: NAD83 

 Projection: New Brunswick Double Stereographic Grid (unless otherwise stated) 

 

Student activity 

Is there a site or sites in the Woodlot where a viable maple syrup making operation, now or in the 
future, might be established? Where? 

What would determine viability? Certainly, the presence of mature sugar maple in significant 
amounts would be critical. Equally important, however, from a sap-gathering point of view, would 
be distance to an existing trail or road.  

As is often the case, an analysis does not have to seek a yes-or-no, black-and-white answer. In this 
case, you could produce a good analysis by compiling data for various classes of sugar maple 
amount and haul distances. 

With these things in mind, your analysis will involve a two-way classification of Woodlot stands. 
Tolerant hardwood stands will be partitioned into three haul zones—25, 50, and 75 meters (m) 
from a road—and they in turn into three sugar maple content classes: sufficient presently, future 
potential, and limited potential. By combining the two pieces of information, a sap production 
potential by haul zone summary can be compiled. 
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Results expected 

An Excel summary table of area totals (m
2
) by 25 m haul zones and sap production potential  

future potential (FP) and present potential (PP) 

 

Data available 

 Cover types feature class: cover 

 Stand volumes table: volumes 

 Main road centerlines: clines 

 Secondary roads feature class: roads 

Solution steps 

1. Create haul zones around roads and trails. 

2. Associate haul zones with tolerant hardwood stands. 

3. Classify stands by sap production potential. 

4. Summarize sap production potential. 

CREATE HAUL ZONES AROUND ROADS AND TRAILS 

GIS is ideally suited for creating zones that is, buffers around linear features such as roads. In 
this case, you'll buffer main road centerlines and secondary road features as a run-up to 
partitioning Woodlot stands into three haul zones—25, 50, and 75 m. The road features can be 
found in the cline and roads feature classes. 

RELATED CONCEPT: RECLASSIFY SPATIALLY BUFFERING FEATURES 

1 Start ArcMap™ and, if you haven't already done so, use Environment Settings to establish your 
Woodlot geodatabase as both your Current Workspace and Scratch Workspace. 
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2 Add the roads and clines feature classes as layers. 

The map display should now show the network of main road centerlines, easements, and 
secondary roads. 

You don't need the easement features in Centre Lines, so get rid of those. 

3 Use Definition Query (right-click clines » Layer Properties » Definition Query) to exclude easement 
features from Centre Lines with the query expression:  

[CLASS] <> 'PE' AND [CLASS] <> 'SE'. 

 

Figure 1. Main road centerline (green) and secondary  
road (red) networks. 

If you open the attribute table, you should see records for 22 features. 

To avoid confusion later, it's always good practice to change a layer name where features have 
been excluded. 

4 Change the Centre Lines layer name to Main Roads CL. 

Now you can start your analysis of sugar maple sap production potential in the Woodlot by 
creating haul zones around its main and secondary road networks.  

ArcGIS makes it simple to create zones around features, like roads, with its buffer tools. In this 
case, you'd like three concentric buffer zones, each 25 m wide, around the networks of roads in 
the Woodlot. 

Before you can buffer the road networks, however, it's probably easiest to collect all road 
features into a common feature class. 

5 Use the Merge tool (Data Management Tools » General) to combine Main Roads CL and Secondary 
Roads into a feature class named allroads. 
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Now you can get on with the task of creating 25 m haul zones around roads. 

Sap-producing trees that are 25 m from a road or trail could be easily accessed on foot and sap 
carried by bucket to the roadside for transport to a nearby processing facility. On the other 
hand, trees between 25 and 50 m from a road could be accessed on foot or on snowshoes and 
sap hauled  to the roadside using a sled. Last, accessing trees beyond 50 m would be feasible 
only by using a snowmobile or a four-wheeler hauling a sled. This, however, would not be 
practicable beyond 75 m. 

6 Use the Multiple Ring Buffer script in ArcToolbox™ (Analysis Tools » Proximity) to buffer road 
features in allroads to 25, 50, and 75 m. Name the new feature class zones_allroads. 

 

Figure 2. Buffering roads in three 25 m concentric rings. 

This task may take a minute or so, depending, of course, on the processing speed of your 
computer. 

If you zoom in on the result, you'll see that ArcMap has conveniently symbolized each zone with 
a unique color. 

 

Figure 3. Zoomed in on 25 m (green), 50 m (pink), and 75 m (blue) 
haul zones around roads. 
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7 Open the zones_allroads attribute table for additional insight. 

 

Figure 4. Haul zones attribute table. 

The table has the usual pair of fields found for polygon features, Shape_Length and Shape_Area, 
plus a distance field. The latter records the distances of the outer boundaries of your three haul 
zones: 25, 50, and 75 m. 

Watch out. In case you have forgotten, if you saved the buffer result as a shapefile external to a 
geodatabase, feature areas and lengths would not be calculated. 

Surprisingly, the table contains only three records. There would certainly seem to be more 
features than that in zones_allroads.  

Question 1:  Why are there just three features (records) in the Multiple Ring Buffer result?  

With haul zones created, it's now a matter of associating them with tolerant hardwood stands that 
contain sugar maple trees. 

ASSOCIATE HAUL ZONES WITH TOLERANT HARDWOOD STANDS 

Sugar maple, being a shade-tolerant tree species, is often found growing with other tolerant species, 
especially American beech and yellow birch. For that reason, tolerant hardwood stands have the 
greatest management potential for sap production. For one thing, these stands often contain 
significant quantities of sugar maple, and second, sap production potential can be increased over 
time through selective removal of nonsap species. 

In this step, you'll first locate tolerant hardwood stands in the cover types feature class. These are 
easily identified; they'll be the ones composed of 50 percent or more tolerant hardwood species. 
Then you'll overlay the tolerant hardwood stands with your recently created haul zones in 
zones_allroads. This will partition the stands into three haul zones: 0–25 m, 25–50 m, and 50–75 m. 

RELATED CONCEPT: RECLASSIFY SPATIALLY OVERLAY 

1 Add the cover feature class as a layer. 

Now, you should also join the volumes table to the Cover Types attribute table. 
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The volumes table contains, among other things, volume percentages for various species groups, 
including tolerant hardwoods (TH_), for each of the Woodlot's 533 stands. 

2 Join the volumes table to the Cover Types attribute table via the STAND_ID and Stand# fields, 
respectively. 

 

Figure 5. Joining the volumes table to the Cover Types 
attribute table. 

Question 2:  What does the Keep only matching 
records option accomplish? 

3 Select tolerant hardwood stands in Cover Types that is, TH_ >= 50 using Select By Attributes.  

This, of course, locates all tolerant hardwood stands in the Woodlot. If you open the attribute 
table, you'll see there are 54. 

If you symbolize Cover Types polygons with a hollow fill, you'll see how the haul zone buffers in 
zones_allroads cut through Woodlot features, including the 54 tolerant hardwood stands. 

 

Figure 6. The 25 m haul zones superimposed on Cover Types features. 



Calculating Forest Values: Evaluating maple sap production potential Glen Jordan 

 8 

This is fine, but what you really need is a new feature class, derived by partitioning the 54 
tolerant hardwood stands into different haul zones. 

Either an intersect or union overlay would accomplish this. However, since you're only 
interested in the 54 tolerant stands, an intersect makes the most sense. 

Question 3:  What's the difference between intersect and union overlays? 

4 Use the Intersect tool (Analysis Tools » Overlay) in ArcToolbox to intersect the 54 tolerant 
hardwood stands in Cover Types with zones_allroads and produce a new feature class named 
sap_zones. 

 

Figure 7. Intersecting 25 m haul zones and tolerant 
hardwood stands. 

Most ArcToolbox tools limit processing to selected features, or all of them if none are selected. 

To see sap_zones features clearly in the map display, you'll want to turn off zones_allroads, and 
then zoom in on one of the selected tolerant hardwood stands. 

5 Turn off zones_allroads and then zoom in on the selected tolerant hardwood stands in Cover 
Types. 
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Figure 8. Tolerant hardwood stands partitioned into 25 m haul zones.  

Features that you see in sap_zones were created wherever zones_allroads buffer features 
intersected tolerant hardwood stands. 

Always bear in mind that the overlay tools can produce a result with multipart features, even where none 
exist in the inputs. 

6 Check the attributes of some sap_zones features using the Identify tool.  

You'll find that features have the attributes of both Cover Types (including the joined volumes 
table) and zones_allroads. 

You'll also find multipart features in sap_zones. Polygons within the confines of a single tolerant 
hardwood stand that share the same distance value occur as a single feature. This will not 
hinder your analysis. 

You now have the Woodlot's tolerant hardwood stands reclassified into three sap haul zones: 
distance values of 25, 50, and 75 m. 

That brings you to your next task—classifying the sap haul zones by sap production potential based 
on their sugar maple content. 

CLASSIFY STANDS BY SAP PRODUCTION POTENTIAL 

Classifying tolerant hardwood stands by sap production potential is simply a matter of developing 
some sort of labeling scheme that reflects relative content of immature and mature sugar maple 
trees. 

It doesn't take that many mature trees on a given hectare to produce economical amounts of sap. 
Experience suggests that just 150 mature trees per hectare is sufficient. Given that a fully stocked 
stand at maturity typically has between 1,000 and 1,500 trees per hectare, mature tolerant 
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hardwood stands with at least 10 percent sugar maple content are capable of economical sap 
production. On the other hand, immature tolerant hardwood stands with at least 10 percent sugar 
maple content would have future sap production potential, provided their long-term management 
favored development of sugar maple over other species such as American beech and yellow birch. 

You could use an ordinal ranking scheme like the following to classify stands' sap production 
potential. Here, sugar maple amounts recorded in the volumes table fields are used to classify stands 
into three categories—Present Potential, Future Potential, and Limited Potential. 

Label Description Stand condition  

PP Present Potential (large sugar maple trees 
present) 

(SM_S + SM_V)/VH >= 0.10 

FP Future Potential (smaller sugar maple trees 
present) 

SM_P/VH >= 0.10 

LP Limited Potential (limited sugar maple trees 
present) 

None of the above 

Table 1. A scheme for classifying sap production potential of stands based on sugar maple content 

RELATED CONCEPT: RECLASSIFY USING THEMATIC ATTRIBUTES TO LABEL 

1 Add a new two-character text field, called Sap_Potential, to the sap_zones attribute table. 

It's now a matter of populating Sap_Potential with PP, FP, and LP labels. Doing this will involve 
selective queries and Field Calculator. 

Start by finding all mature tolerant hardwood stands with sugar maple content at least equal to 
10 percent. That means finding stands in sap_zones where SM_S (sawlog-size tree volume/ha) 
plus SM_V (veneer-size tree volume/ha) is 10 percent of total stand volume/ha (VH field). 

2 Use the following query expression as a guide to find all mature tolerant hardwood in sap_zones 
with sugar maple content at least equal to 10 percent. 

(SM_S+SM_V)/ VH >= 0.10 
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Figure 9. Selecting tolerant hardwoods where sawlog and 
veneer-size sugar maple trees make up at least 10 percent of 
stand volume yield. 

Question 4:  What purpose do those 
parentheses ( ) serve in a Field Calculator 
expression? 

Three features satisfy your query and are selected. 

If you zoom to selected features and look closer, you'll find that they represent three distinct 
haul zones—25, 50, and 75 m within part of stand 1046. 

 

Figure 10. Present potential stand 1046 partitioned into three 

haul zones 25, 50, and 75 m. 

It's time to label the three selected features. 

3 Assign the three selected features a Sap_Potential of "PP" that is, present potential using Field 
Calculator. Remember to put quotation marks around "PP", or you will get an error. 
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Now you can locate sap zones with future potential and label them as FP. These will be zones 
not already labeled PP where SM_P (pulpwood-size tree volume/ha) is 10 percent of total stand 
volume per hectare (VH field). 

4 Query sap_zones as follows and then label selected features as FP in the Sap_Potential field. 

SM_P/VH >= 0.10 AND Sap_Potential Is Null 

Again you'll find just three features. These sap zones have immature sugar maple trees in 
adequate amounts but will need more time to reach a size where sap production is sufficient for 
economic extraction. 

 

Figure 11. Future potential stand 817 partitioned into three 
haul zones—25, 50, and 75 m. 

5 Select the remaining unlabeled sap zones that is, Sap_Potential Is Null and then label 

them LP for limited potential. 

There should be 122. They have neither mature nor immature sugar maple trees in sufficient 
quantities. They have limited potential for sap production, except with intensive management. 

6 Clear selected features. 

The previous Select By Attributes and Field Calculator procedure is common practice in 
reclassifying. It can, however, get quite laborious, especially when the classification is quite 
complex or lengthy. There is an alternative. You can use VB code in Field Calculator. 

Try it in calculating Sap_Potential values. 

7 Use Field Calculator to clear the Sap_Potential field in sap_zones that is,  
Sap_Potential = "". 
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8 Right-click Sap_Potential and open Field Calculator as usual, but this time in the dialog box, select 
the VB Script and Show Codeblock options.  Then enter the following VB statements and calculate 
Sap_Potential = Label.  

Dim Label 

'       Present potential - Sugar Maple sawlog and veneer-

sized trees at least 10% 

 If ([volumes_SM_S] + [volumes_SM_V])/[cover_VH] >= 0.10 

Then 

   Label = "PP" 

'      Future potential - Sugar Maple pulpwood-sized trees 

at least 10% 

ElseIf [volumes_SM_P]/[cover_VH] >= 0.10 Then 

   Label = "FP" 

'      Limited potential - none of the above 

Else 

   Label = "LP" 

End If 

 
 

 
Figure 12. Labeling for sap potential using VBScript. 

Hopefully, you can see the logic of the VB coding. A little Visual Basic programming know-how is 
a powerful thing. 

One way or another, you've completed your two-way classification of tolerant hardwood stands 
in the Woodlot—haul zones by sap production potential. 

There doesn't seem to be a lot of present potential for maple sap production in the Woodlot, 
with only one suitable stand occupying acceptable haul zones—25, 50, and 75 m.  
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The future doesn't appear much better, again with only one stand that's suitable for management. 
But perhaps the areas involved are large, or most of the area is within 25 m of a road. The next step 
is to find out. 

SUMMARIZE SAP PRODUCTION POTENTIAL 

How might you best summarize your results so that you have Woodlot area totals for each sap 
potential category and haul zone? 

Computing a cross tabulation of area totals by your sap production classes (Sap_Potential) and 25 m 
sap haul zones (Distance), as illustrated below, would be ideal.  

Sap_Potential 

Distance PP  FP  LP  

25    

50    

75    

Table 2. Desired cross tabulation of haul zones (Distance) by sap production potential (Sap_Potential) 

RELATED CONCEPT: CHARACTERIZE USING A NUMERICAL DISTRIBUTION 

Unfortunately, the ArcMap summarize function does not support cross tabulations, at least not 
directly. For the above table, you'd have to calculate three summary tables, one each for 25, 50, and 
75 m. 

There is another option Microsoft Excel. 

1 Start Excel and use it to open the sap_zones attribute table in your geodatabase (Data » From 
Access). 
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Figure 13. Accessing the sap_zones attribute table using Microsoft Excel. 

Excel displays a spreadsheet that is pretty much a mirror image of the sap_zones attribute table. 

 

Figure 14. The sap_zones attribute table opened as a spreadsheet in Excel. 

2 Open Pivot Table functionality (Insert » Pivot Table) and define the desired cross tabulation. 
(Click in the upper-left corner of the spreadsheet to ensure that all columns and their rows are 
selected.) 
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Figure 15. Computing a cross tabulation of Shape_Area totals by Distance and Sap_Potential using Pivot Table. 

3 Format the resulting table as illustrated in the figure, substituting aliases for field names, 
dropping the LP category altogether, and reducing decimal places. 

 

Figure 16. Cross tabulation of area totals (m
2
) by Distance and Sap_Potential. 

You'll observe that overall there isn't a large amount of Present Potential (PP) tolerant hardwood 

area in the Woodlot less than 1 ha in fact. There's a miniscule area within 25 m of a road, 
about 0.3 ha between 25 and 50 m, and 0.54 ha between 50 and 75 m. These amounts would 
not support a maple syrup-producing facility. 

Is there better news in the Future Potential (FP) category? 

There, overall, FP area totals just over 1 ha, with about 0.5 ha within 25 m, 0.42 ha between 25 
and 50 m, and 0.25 ha between 50 and 75 m. These amounts would not justify the management 
expense needed to bring stands to a producing state. 

Question 5:  How would you compile a cross tabulation in hectares rather than square meters? 
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Conclusion 

What have you learned, aside from the fact that the Woodlot can't support a maple syrup operation, 
now or in the future? 

Your analysis used some of the same attribute reclassification and summarizing functionality often 
used in forest valuation, whether economic, social, or ecological. Visual Basic programming in Field 
Calculator proved helpful. In this exercise, however, you used locational attributes of proximity 
(buffering) and coincidence (overlay), as well as thematic attributes, in reclassifying stands. 

Last, Microsoft Excel can be a useful ArcGIS companion. 

Submit your work 

 A cross tabulation of 25 m haul zones by three sap production potential categories—
present potential, future potential, and limited potential 

 Answers to the questions posed in the exercise: 

1. Why were there just three features (records) in the Multiple Ring Buffer result? 

2. When joining tables, what does the Keep only matching records option accomplish? 

3. What's the difference between intersect and union overlays? 

4. What purpose do parentheses ( ) serve in a Field Calculator expression? 

5. How would you compile your cross tabulation in hectares rather than square 
meters? 

 A summary of the exercise, indicating where and how related reclassify and 
characterize concepts and analysis techniques are used (Your summary could take the 
form of a table that checks off each of these elements.) 

 Calculation of sap production potential in another forest property using techniques 
similar to those used in this exercise 

Credits 

Sources of supplied data 

Course Data 
Data\cover, courtesy of University of New Brunswick Faculty of Forestry and Environmental 

Management 
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